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INntroduction

Hearing Instrument Testing (HIT) measures the hearing instrument response in a 2 cc coupler in the
test chamber. The coupler response is then compared to the manufacturer specification to ensure
quality performance or to detect possible malfunctions of the hearing instrument.

This system follows the ANSI S3.22-2003 and IEC 60118-7 (2005) standards for hearing aid
measurement methods.

The Avant Polar HIT supports the following measurements:

OSPL-90 Frequency Response Input/Output (AGC) Induction Coil
Full on Gain Equivalent Input Noise Battery Current Directionality
Reference Test Gain Harmonic Distortion Attack/Release

The AVANT Polar HIT represents a new era of precision Hearing Instrument Testing for your office.
Compact yet rugged, this PC-Based system is USB powered and performs all required ANSI and IEC
tests. A unique feature of the Polar HIT is a rotating test pad, which allows you to generate polar plots to
verify the performance of directional microphones upon delivery and following repairs. This manual will
explain the available tests and provide step-by-step instructions for all supported tests.

This manual assumes that the system hardware, software and drivers are installed and working properly.
Please refer to the MedRx Avant Polar HIT Installation Manual for assistance.

The scope of this manual is to get you “up and running” with the AVANT Polar HIT System. Please
consult the interactive Help System within the software for more detailed information of features and
functionality. To access this tool, press the F1 key at any time, or click the Help menu with your mouse.
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The AVANT HIT Software

General Overview

The AVANT HIT software will either run as a part of the AVANT Software Suite (figure 1), or as a stand-
alone module (figure 2). The AVANT Software Suite can run stand-alone or from NOAH System or the

TIMS NOAH-Compatible Office System.
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Figure 1 The AVANT Software Suite Main Screen

Launching the HIT Software

Stand Alone

1. Double click the AVANT HIT shortcut
on your Windows Desktop
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Figure 2 The AVANT HIT Stand-Alone Main Screen

NOAH and TIMS

£ Module Selection 3]

Fitting  Measurement IUthEr |

AVANT

N

NOAHaUH 3 Avant

Licensed to: - MedRix, Inc. - SALES - SALES LICENSE, FOR INTERNAL

Cancel

1. Launch NOAH
2. From the Module Selection screen, double click
the AVANT icon
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Software Options

Basic Options

The software allows you to set several default options as described below.

Options g|
Wigw %HIT ]
Plot : :
™ Vertical Grid Default Ear: |Right vi

¥ Horizontal Grid

Plot Curves width: 1Medium A
Sight-

Style: | Lines A
Size: |90

V' Maintain Plat Ratios

W Use Plat Antigliasing

ak | Cancel ‘ Help ‘

The View tab allows you to set the default
appearance of the HIT test environment.
Values can be changed by using the check
boxes and pull-down menus shown above.
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Options

View HIT |

Standard: | aNS|

Average Readings:

Smooth Plats: 13 v

Start Sweep Frequency [Hz]: 128 -

[~ Show SPL Reference Curve

QK | Cancel I Help ‘

The HIT Tab allows you to select the
relevant Standard for your measurements
(ANSI S3.22-2003 or IEC 60118-7 2005) as
well as the general parameters for your HIT
measurements.
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Advanced Options

The Advanced Options screen allows you to
configure your system to meet your individual
clinical needs. It also provides MedRx
Technical Support with tools for helping you
troubleshoot problems. Access this screen
from the File Menu on the Avant Main Screen
as shown to the right.

The key features of each tab are described below.

interactive Help system within the software.

Advanced Options E‘

General | Audio | DSP | Video |

¥ Boost Pricrity During Measurements CO-ROM Drive: | D: v}

™ Multiple Monitors
[ Do Mot Disconnect fom NOAH when Fiting
Language ‘

System Information Device Manager ‘

ii! Function Help

Clzar Session Data I

Prink Setup...
Page Setup...

Cptions. ..
Advanced Options. ..

Exit

For more in-depth information, consult the

Advanced Options E‘

General  Audio WDSF‘ 1 Yideo ]

Output Device:  |[ETERRNR A

Input Device: ‘Mede HIT Audio ﬂ

Mier Device: | MedRx HIT Audio |

Audio Properties Audio Mixer ‘
oK Cancel ] Help ‘ oK Cancel ] Help ‘

The General Tab configures the overall Avant
HIT environment and behavior with respect to
other Windows program, specifically NOAH.

Advanced Options E‘

Eenalal} Avudio 05%1\/"\1135 ]

Direct Sound FFT

Capture Buffer Legnth [ms):
Playback Bufer Length [ms]: |100

Sample Size: | 8192 -
Transfoms Per Second: |16 3:

MNoWindowing [

Use the Audio Tab to select the proper audio
device for your Avant HIT. If necessary, this
tab also provides access to the Windows
Audio controls.

Advanced Options E‘
Eenalal} Audio ] DSP V\dew

Otoscope Input

Device: [Not Awaikable =l

1 1

Alernative [nput

Device: [Not Awailable =

o]

Cancel ] Help ‘

o]

Cancel ] Help ‘

The DSP Tab controls how the device handles
digital sound. DO NOT change these
settings unless instructed by a MedRx
Support Engineer.

MedRx Avant Polar HIT
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If your system has a Video Otoscope, this
Tab allows you to select the appropriate
device driver.
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Preparing for Testing

Attaching Hearing Instruments to the Coupler

ITE (In The Ear), ITC (In The Canal) and MIC (Mini Canal) Hearing Instruments

1.
2.

3.

Seal acoustic vents

Wrap the canal portion of the instrument with a hermetic sealing material such as Bostik Blu-
Tack (see Figure 1).

Align the sound bore with the opening of the ITE coupler adapter. Press the sealing material
firmly into the ITE adapter (see figure 2).

Ensure that the black o-ring is installed in the 2cc coupler and snap the ITE adapter in place
(see Figure 3).

Figure 1 Figure 2 Figure 3

BTE (Behind The Ear) Hearing Instruments

1. Remove earmold from hearing instrument
2. Attach ear hook to 20mm long Tygon tube on BTE Coupler Adapter (see Figure 4)
3. Snap the BTE Coupler Adapter onto the 2cc Coupler (see Figure 5).

Figure 4 Figure 5
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Attaching Hearing Instruments to the Coupler (cont.)

Hearing Instruments with Button Receivers

1. Remove earmold from hearing instrument
2. Attach the button receiver to the Coupler Adapter and seal with putty (see Figure 6).
3. Snap the Button Receiver Coupler Adapter onto the 2cc Coupler (see Figure 7).

Figure 6 Figure 7

Positioning Hearing Instruments to the Test Chamber

The AVANT Polar HIT chamber utilizes two speakers positioned 90° apart. When placing hearing
instruments in the chamber, it is critical to align them so the primary hearing instrument microphone is
perpendicular to the grille of the primary speaker. The Primary Speaker is on your right. Proper
positioning for ITE, BTE and Body Worn hearing instruments are shown below.

ITE Hearing Instrument BTE Hearing Instrument Body Worn Hearing Instrument

Once the instrument is properly placed in the test chamber, turn the power on and close the lid of the
chamber. The latch will engage which an audible “click” when the lid is closed properly.

Notes:

1. ITE instruments are aligned as if they are being worn and the patient’s nose is facing the
Secondary Speaker.

2. BTE instruments are aligned as if they are being worn and the patient’s nose is facing the
Primary Speaker.

3. Battery pills are used for ITE and BTE Instruments, but not for Body Worn Instruments.
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Making HIT Measurements

General overview

The AVANT Hit software is designed to make the process of making HIT measurements simple.
The easiest way to complete them is to use the Auto Test feature.

Setting Auto Test Preferences

Unselected Tests:

Hearing &id

Type: [Linear  + @

Selected Tests

G5PL-40
i | |

Gain
Reference-Test Gain

Frequency Response
<-Remave | |Equi. Input Noise

Harmonic: Distortion
Battery curent
Input-Output
Attack/Relsase

Stimulus: | Tore =

V Frequency Response
v Equiv. Input Naise

¥ Harmonic Distortion
v Battery current

v Irput-Output

v Attack/Release

¢ Induction Coil

« Directionality

oo (D)sem,

nwEw

Level (@) [50 ]
Volage: [13@ncai] = 2]
Test Frequencies (Hz) e i
T M bulipi: ‘ mj m{r‘f -
1000 | |500 _ Mokse TR
1000
Polar éngle Stepr 115« 2500
Change | |4000
Load Save @
Help oK Cancel ‘ o ‘ @
f | ] | | Smwse
* 4k o s

No g

From the AVANT HIT Main screen, click HI
Test

Click the Setup button below the list of
tests

In the Test Setup Window, add or remove
the tests you want to include in your Auto
Test battery

Select the appropriate amplifier and battery
type

Select the test frequencies you wish to use
Click Save to store your preferred settings
Click OK to close this window

After setting your default preferences, simply place the hearing instrument into the test chamber
as described in the Avant Polar HIT Installation Manual and click the Auto button then click Start.

MedRx Avant Polar HIT
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Sample HIT Measurements

The screenshots below illustrate the Avant Polar HIT representations of the ANSI S3.22-2003 Hearing
Instrument Test Battery. The system also supports the IEC 60118-7 2005.

|3‘I.0 dB Target
|3‘I.ﬁ dE Measured

Cancel |
OSPL90 Full-On Gain Reference Test Gain

Frequency Response Equivalent Input Noise Total Harmonic Distortion

Attack/Release

Battery Current Input/Output

Induction Coil
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Testing Directional Hearing
Instruments (Polar Plots)

The Avant Polar HIT is unique in its ability to produce manufacturer-quality Polar Plots in your office. This
is accomplished using the Avant Polar HIT software and the unique Rotating Test Pad.

1. Select the Directionality Test from the list =
on the right of the screen. 7 OSFL. a0
¥ Full-On Gain

v Reference-Test Gain
¥ Frequency Pesponse
¥ Equiv. Input Noise

¥ Harmanic Distartian
¥ Battery current

¥ Input-Output

¥ Altack/Release

« |nduction Coil

x 5
2. Click O | e | | Setup |
3. Click @

NOTE: During testing, the software will prompt you to rotate the test pad either clockwise or
counter-clockwise. Please refer to the figure below for reference.

Ckw'\se

Counter ClO
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4. Follow the screen prompts (circled in red below) to complete the test. A completed Polar Plot is shown
below.

AvantHIT - Hearing Instrument Testing - ANSI [Directionality]

¥ Reference-Test Gai
¥ Fiequency Response
v Equiv. Input Noise

v Harmaric Distortion
¥ Baltery current

¥ Input-Output

¥ Attack/Release

' Induetion Cal

« Directionality
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Printing

The AVANT POLAR HIT software allows you to print tests individually or as a complete multi-
test report.

Printing Individual Tests Printing Multi-Test Reports
1. Click File =2 AvantHIT - Hearing Instrume| 1. Click File {22 AvantHIT - Hearing Instrumer
2. Click Print M Options...  Tools  Help 2. Click Print Report M Options... Tools Help
Open Open '
Save Save
Print Setup,.. Print Setup...
Page Setup... Page Setup...
Repart Preview Report Preview
Prink Report. ..
Print Prewview Print Presview
Print. ..
Advanced Cptions. .. Advanced Options. ..
Go Back G0 Back
Exit Program Exit Program
MedRx Avant Polar HIT Page 13
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Limited Warranty

MedRx, Inc warrants the AVANT POLAR HIT TM System to be free from defects in
material and workmanship for one year from the time of purchase. If this system fails
to perform as specified during this period, the purchaser is responsible for calling
MedRx at (888) 392-1234. The company's representative will advise the owner to
either return specific components or the entire system to:

MedRx, Inc.
1200 Starkey Road #105
Largo, FL 33771

MedRx will repair or replace any defective parts, fully test the system and/or
components and ship the system promptly back to the owner. There is no cost for this
warranty service, provided the system is one year old or less and has not been
misused, abused or damaged. Such damage includes, but is not limited to, dropping,
exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and
exclusive remedy of the purchaser. MedRx shall not be liable for any consequential or
incidental damages, or for breach of any express or implied warranty. Except to the
extent of applicable law, any implied warranty, merchantability or fitness of this
product is limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty components at the
purchaser’s request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on the AVANT
POLAR HIT TM which is not pre-approved by MedRx, Inc. Approved software includes
NOAH™ and HIMSA approved hearing aid manufacturer programming modules for
fitting hearing aids.

MedRx, Inc is not responsible for problems resulting from installation of unapproved
software or hardware. In the event of unapproved software or hardware installed on
the system causing a conflict with the AVANT POLAR HIT TM functions, MedRx will
service the problem for a fee to be determined at the time of service.

Consult your MedRx Technical support member for other alternatives for back up.
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